DIVE Mg ews

Table

Prirmitives, Duplication, Transformation
w Choose Gel - Primitive = Cube (length of 3 units)

m Select the Mo hierarchy option in the Duplicate = Setup
dialegue bax,

a Duphicate the cube using Duoplicate + Repetition. Create three
copies with a translation of -4 units aloeng the y-axis.

n Hald down the Supra Xey 2 while you cick the right mouse
brution b xoom oot e see all duplicates of the cube

p Switeh e Ml selection rede (chease the Mol mesw cell)
Thiz will allow v select all cubees an anmee while p]'l.“iiil'liﬂl'lt
spaace bar and making a selection box around the cubes.

m Choose Duplicate = Immediate w ereete duplicates of the
group of culies.

m Lse the Translation menu cells or press the Supra Key v 1o
move the cubes. Repeat the doplication process o create four
tabile fegs.

m Switeh hack o Single selection maods and duplicine one cube
for the tabletop

g Use the Seale menu cells ar ress e 5LI'|.'IF.] ]"':\.{'_'g' % Lo scale the
cuhe into a tabletop.

f'_.ll.;._ se che YN :5::.;':|i|11: micsle tooscale an all three axes at
1he sinme e,

You can also scale an objoct numerically by selecting the
small triangular sectiom of the Seale mem cells or
Lrpimg directly i the cells themsehes.
m Choose Get + Primitive =+ Sphere, Crlinder, Cone, and Torus
1o place several obpects on the alle.
# Lnlarge the Perspective view by clicking the jcon in the upper
right corner of the window and then select the Shade view
e,

m Press the Supra Key o while dragaing the mouse to orbit the
camera arcund your maodel.

m Pross the Jupra Kev powhile dragping the moose o dally the
carngra i the Perspective view,
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Jewel 1

Defining a Material Animation by Keyframes

n {heose Get = Primitive + Dadecahedron {use default
setiings).

n Move to the Matter module Ty clicking on the word batier in
the title bar,

w Choose the Material menu cell 1o display the Marerial Editor.

a Change the colowr of the material by clicking the Palette
buttan in the bottom lefi of the Material Edior. Click on a
calour in the palette and select Ok e confirm vour choice.

B Setthe Transparcncy valee e approximately 0.5 and the
Refractive [Index o approsinmately 14,

& Click the Preview button o render the effect of the material en
the madel, Click the middle mouse button in the Preview
window to close it and then chek the Ok button to close the
Mamerial Editor.

m Add alight to the scene by chicosing Light = Deline and accept
the defaull valees. Pasition the light above and in front of the
dedecahedren (translate i), To see the resull of your
modifications, chanse Preview = All,

m Go 1o the Motion module by pressng the F2 Supra ey,

® Make sure the tme line is a1 frame 1 and that the
dodecahedron is selected. Choose SaveRey + Object +
Bestation 1o creane the first kevirame.

p oo frame 100 by dragging the tane line pointer,

m Precs the Supra Kev o to activate rotation. Kotale the culw
several Bimes arounad any axis or combination ol axes.

® Set znother kevirame at frame 100 by chonsing Saveley with
the middle monse button.

w Preview vour animation by clicking on the Forward play armow

in the playback boa at the right end of 1the time line.

' Tio The middle mouse button abways duplicaies the
et previous ment cell command chosen,

17
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Jewel 2

Rendering and Previewing a FlipBook
m Go 1o the Maner module and choose the Bender menu cell

Gl yonr
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m Change the picture resolution 1o 200 aleng % and 165 along v
e

m Type in the file name jewel for vour sequence and click the
Fender Sequence Bution 1o stae the renderi
animation.
The screen will turn Black and the rendering window will
Appear in the centrs with a frame coumter ahave, Once the
rendering is complete, the interface is displaved again. You can
ﬁ.ll:h\FI 1T J"il LG |.|'| & re-'rl-:ir'r | I'IE }I k!' A I'l:l LY Il'u"a h'- I'l i L'.'hhi.l'l_l\..'h [h L

middie mouse button,
U PrevIcy yosr il'l.'1'|l:|{'r{'|:| animE . Al 1 the Tools macedule
the name jewal

and choose 1he FlipBook menu cell.

m Aelect vour file name from the list or tvpe

as the Sequence Name.

m Clck Ok o Joad the images inoe the Hlipbook. Once the images
are loaded in memaory, the Arst image will appear on the

EOTEE.

m Chok the Forward arrow 1o play the dipbock. You can pause
the proview at any tme wsing the maddle mouse button
Fressing all three mouse bunions simuhancously will swop the

Hipbook.
"F'ﬁp_] Tou will and vour rendered images 1 the
: RESDER_PICTURES disectory of vour database.
Chooee the Picture menu cel! in the Toals medule and
use the Dasplay buton in the View Piciores diglogue
box o see individual imrages.

Once 2 flipbook is displaved, pressing the number keys
1,3, 3, erc, will scale the i|'|'|:'.54.':1. g aned down I:||.".|:.

when the plavback is pavsed).

SOETIRAAGE 30 Work ok



Civerview

Planets

[ ' Selections, Mierarchies, and Centres

m Ureate a sphere with default values (Get = Primitive + Sphere)
and mame it Sun by chossing Info = Selection.

m Create the Earth, Moon, and 3%ees by duplicating and
transforming the Sun sphere. Remember to mume each sphere
aecording|lv.

m Change the rotation pivols of the planets and moen by
selecting the CTR mode and translating the axis icons. hMove
Farth's and Mars” centres 10 the Sun. Move the Moon's centre
. to the Larth’s cemntre.

p Create 2 hierarchy of 1the solar system by wsing the Parent
menu cell, Make the Earth the pazent of the Moon, then make
the Sum the parent of the Earth and Mar Refer w the mouse

lites far referenay

a Lxperiment with vour hicrarchy and select the different
branches and nodes by using each mouse buton [3chematic

# Select the Moon and then go to the Motion module,

-~ -
.-"--- T
m & Choose SaveKey o Objoct + REotation to oreete e first
i keyteame on the Moon,

a Move the time line pointer to frame 100 and rotate the Moon
provmd the y-axis by 360 degrees,

m Chonse Savebey = 'l'_]'l:.j:_'r;l; =5 Fobmbion "l"*"‘:“ 13 crcale the new
kevirame [simply wse the middle mouse button on the
mave ey mena cell ).

m Repreal This proceduee For the Larth and Mars.

m Ty assigning different mmterials 1o the sphercs,

m Goto the Matter meduale and choose Bender. Omnee the
rendering % complete, go to the Tools module and choose
Flipbrook 1o view the amimation.

r_'l"lll'-' Scale up the axis icons so that vou can see the centres
R

e casilv

St the animation of the Moo Gran, then sen keviramaes

for the Lranch containing bath the Earth and the
hdocin.

Ear the 3un’s materil, select the Constant Shading
riesilel ned activaoe Sracic Blur,
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Mister Robot

Tt W e ¥ =TT

Hierarchy, Centres, and Transformations

Create a simple robet medel by combining primitives, All voo
nevd for the purpose of this exercise is the upper body of the
rabat.

Choose Get = Primative = Cube with Lengih = 3,

Scale the cubae alomng the y-axis by a Gcor of 2.
I:_':|1-:'-||:u' Gi."l = Prinative = 5|!||!|.|’.‘|{' with Hadios — 2.
Peaition the ephere above the torso to create the head,
Chonse Get = Primitive = Cylinder with Radivs = 0.5

Switch 10 TR (Centred mode and translng the conire of the
cvlinder 1o its wp end.

Switch back to OB (Object) mode. Transform and duplicate
the cvlinder 1o crete the apper and lower arms ol te rabat,

Aded orened cubes o the end of cach arm 1o create hands
falso modify the centres)

l:_'h DINEL 1|'||_'- Parend menu (r:” 4 creale o heriire |1:.' rha will
allow each component of the mechanical arms we be animated

Tress the space bag 10 select and descleot the varicus
COMPonenls,

Experienent with the rabot Teracchy by selecting the entine
1ree, the Branches, and individual nodes.

Helect one of the arms as 2 branch by pressing the space ban
winle |1'i.,'|-:i|1i: e spper anm f:.'lil:u.l{"!" with the middle o
Butlaen.

Cote the Motion madule and choose
.';':-:w-u]'i'.'u:.- + Franch = Bataoagn an frame 1.

Move to frame D00 and reposition the arm.

Sclect the arm as a branch apzin and choose
SaveRey + Branch =+ Botation to create Trame 100

Fley Dack vour animatian,

SOTTIRAGE 30 Wiorgbock
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Your Name in 3D, Part 1

Text, Extrusion
m Chaose Got = Text and sclect 2 Fonl.
= T the Text bow, type vour first same. Click Ok 1o confirm the
fexl enleys
m [nthe Front windew, epen a Schematic window and look
the hicrarchy.
s Choose Surface + Extrusion o extrude the text as a Polvgon
Mesh abject using tie following parameterns:
- Polvgon
- Subilivision - 5
Revelling - Aot
- Radius - .1
- Wi Rewels -2
- Top bevelling only

- Close - on

“w Hide the original faces by selecting them (in the Schematic

view ) and choosing Display + Hide = Toggle Selection. The
faces will be the Targer group of oljects because vack character
has ant least one null associzied with it for olject placement,

m Select the Shade view mede in the Perspective window and use
the Supra Key o to orbit the caenesa around vour oliject.

& Save the scene For use in later workshop projests.
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Model Module

Wine Glass

Grid Lock, Drawing Splines, Revalution

n Enlarpe the From window 1o full size

a Chaose Show + Paint 1o display the conral points on the
profile corve,

w Choose Draw = Curve + NURBS and draw the profile of 2
wine gliss using the arigin of the global axis 2s your starting,
pexint.

a Choose Preferences + Create Modelling Relation [off by
defauls)

w I the tile Bar of the From Window, click the Layout icon and
arn Grid lock ON for the % and y-axes. Make 1the grid smaller,
such as 05 or 025, instead of 1.

m Mowe the first and last poines so that they "snap” 1w the v-axis.
Dieactivate the Grid lock.

# Choose Fdit = Move Paint, Bdat the points of the spline umil
you ohrain 2 nice profile curve.

m To create the wine glass volume, choosy Surface + Revelution
andl use the defaul values of 360 degrees with & steps, Make

n Select the Shade view maode in the Perspective window,

w Hthe surface is "dark,” inverse the original profile curve,

m Use the Supra Koy o to arbit the camera arcond the wine gl

® Save vour scene for use in other projects.

» Try clanging the shape of the wine glass by editing points on
the ariginal spline.

s With the original prohle curve selecied, chocse Info +
Selection (N URES Curve Info dialogoe bos ) and fower the
step value fromm 10 oo 3. Since the modelling relation is in
elMect, the wine plass will avtematically be updated.

m The step value sets the refinement of the curve hetween
control points.

p Turn off the modelling relation befors the next exercise,

|"-I.--_|-l|j } When draving the profile curve, nse the Supea Key 2o
o ol in the Front window aoud obrain a smaller
gric.

Hevolutions can happen around any axis, ut the v-axis!
Front window combination has been the convenion
the past.

Freeing the madelling relation allows vou to manpulane
individual poini as in the two smaller tllesirations.




Maodel Module

Sailboat

Skin, Tag Points

m Choose Get = Primitive + Arc with a radivs of 3, Beginar 180,
and End at 380, Make it 2 B-Sphne curve,

» Choose Doy = OpenfClose te close the arc, then choose
Shew + Point 1o display 1he points on the spline, Use the
Supra Key m to move the fwo top points down 1o flatien the
top of the corve.

m MNake sure Preferences + Create Modelling Relations is
inactive (the defaualo),

s Choose Duplicate + Repetition and make five copies of the arc
with a Etﬂ]i.l'lﬂ Gretor of 0.5 aleng cach axts and a Teanslation of
3 wmits along the 2-axis,

n Select the eriginal are and repear the duplication o create
three copies, et change the Scaling factor 1o 0.75 zlong cach
axis and the Translation e -3 units (nepative] along the e-agis.

m Select the original are (the largest) and use the Supra Key 1o
tag the point in the centre of the are, Change o TAG mode and
move the tagged peint down along the v-axis by ahout one
umnit.

p Tag one more contrel point on ¢ach side of the centne point
and scale the three tagped points along the x-axis e create the
kel of the sailbnar.

p Chonse Sueface = 5kin and select #ach cross-section m
sequential order starting Tfrem the seigilest sploze fuse the Right
window view far referencel. Once each a2 has been selectad,
click the middle mouse button. Select Parch and B-Sphine in
the 5!.-'J]'.I'Iil13|_! -:_:|'.:|'|-.‘:-Eul." ke and click Ok

» Choose Info + Selection and astivale Capping for the Botlom
af the U B-3pline, This will close the bow (the front tip] of the
buzat,

® Inany window, select a Schematic view. Held dovwn the space
har and <lick on thie varios nedes to select the ars at the back
of the leant (the sternl.

m Choose Draw 2 Convert to Face o make the curve into g
surface. Finish the sailboat by adding a mast (oylinder] and
siils {skin between two curves :g.u:l'i'.'.: e r||-.‘:-|'|3 the rast amd
the other along the boaml.
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Miadel Module

Ice Cream

Duplicate Repetition, SKin

Chanse Get = Primitive = Cirele with a radiug of 5 unils.
Make it a B-3pline Corve Type and increase the Step valoe to
16.

Chocse Show + Peint to display the contral ponts along the
circumterense af the cincle,

Switch o tagged peint manipulation meds by dicking TAG in
the lower-right part of the sceeen. n the Front window, Toeld
down the Supra Key tand the lef mouse button and tag
alternating points along the edge of the circle. You should 1ag
cight points im 1ol

Activine the Scale menu cell ane scale 1he raged points along
Both the x and y-axes 1o create a scalloped circle. Hold down
H TS Sllj':"l- 'I-..:c:r' i and the mddle mouse lattan 10 untap the
?L’I]:‘_[j 'I.'h'|'|l:'|'| '|'l;l|.| il re I:Ii“'.l.'.

Choose Duplicate + Repetition using the follinving settings:

Mir ol orenrences: 5

S X=07 Y =07 Lo
Bolation: n=i ¥ =0 L=125
Transhting: X=0 T=A EA

Tev see all the new ebiects in the windows, press the Supra key
A {shift-a) and click in each window w frame the views,
Chiose Select = Clear e deselect the ahjecrs. Switch back 1o
OB Object) maode.

Choose Surface =+ Skan and use the lefs mouse bunios 1o selea
each slice starting from the largest 1o the semallest civcle. Onaoe
every slice has been selected, click the middle maousse oo,
Select Patch and B-5pline in the dialogaee hox.

Choose Info 2 Selection and activate Top for the U Cappng,
Rotate the abject -9 degrees around the x-axis.

Select the Shade view mode in the Perspective window wnd use
the Supra Key o o orbit around your delicinus creation!

il Tip } Trv using a lattice o bend the tip of the ioe cream by

tagging and roming subsequent lattice sections (nd
untagging some latiics point, mtane, eic)

i



Maodal Module
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Jojo the Happy Fish, Part 1

Modelling, Hierarchy

s Chooss Get + Primitive + Sphere using the default values,
Select Cubic NURES in L and W

p Choose Show =+ Point i display the coneral points on the
sphere.

Rotate the sphere by 90 degrees on the x-axis

Scale the sphere o .;_p:_:-r-:_'.;-;i |11:|.I|_"|:_.' (L1 &n the ¥-axis.

Choose Lifect = Preezs = Transfocmations (needed for the
TEEsE EXETCISE ).

Fnlarge the Right window and switeh to TAG manipulation
o

m Tag the second column of points to the right of the centre
rabout -2 units on e eeoaxisl

Scale the tagged points along the y-axis w define the body and
1ail sections of [ojo the Ash. Untag the points

Tag the highest and lowest points on the 1l section and
translate them along the z-axis w create the il fins.

m Adil the eyes, the pupils, and create the mouth from a weros
folded in half {1ag and cotate], Use Svammetey omothe fnished
ave 1o make the second (Y planel.

Tov ereate a lierazchy of Jojo the fish, follow these steps:

m Hnld the space bar down while selecting one of the eyes with
the left mouse bution, Change w Parent mede and pick the
corresponding pupil with the left mause button, Click the
right mouse butten to end the Parent mode, Repear the

E:-nc_'-l.r'-ﬂ‘:'.r-!' oz 1he ciher oV,

m Select the body of the fish. Activate the Farent mesde and pick
the mouth and the eves with the leli mouse baton. Open a
Schemaric window 10 verify the hicrarchy.

m To create the ocean floor, choase Get = Frimitive = Grid psing,
the defauls settings = make it o MURES serface. Translaie the
wrid under the fish,

m {hoose Effect + Randomize using thess settings: X = 0,03,
W= 005, L= 005 Seale the grid on the y-axis oo adjust the
deformation effect.

8 Finish vour scene by adjusting the sizes of the medels.

CEETIRE R T = TR bk T b



PAGClel Mool e

- g s ",
S A ) n
l'r.r-“"'\::' . 4 | L}
[ ! I
| II"‘-\.:'._ iV L i iz
LY Pl ""IIIIII S ¥ I
R i [
RS sy W I
.\'\'\.\"\_l-'- .I.\-III_ i -
-
| - -
= = ey, .
et e
e d %
A A
_;_.-' - -.'.q'll | -y 3
- i 4 il

A Al e -l ] i TN Eay Sy |

Logo

Deformation, Effects, Patch Fitting

m Choose Get = Primitive = Sphere. Make iva - Spling Parck
with a Badins of & wmts.

a et the sceme comaining vour extruded name (see "Xour
Thame i 30570

m Make ane af the wincdowes o Schemanic view,

m Parent the individual leners waether. Select the "5 hrse, and
pick the A and M as children

) e vk Lmagin ation il':.'-:'-l.lr name isn't .:I.t'.l.l..I”_‘:.' Sarn

Nove it's “Billy Stembobilicchlo™, then vou've gota lot of

parenting ahead of vourself, ITaot, consider yoursell

lucky!

m Cheoose EMfect » Subdivision 1o subdivide the logo inoe a
larger number of polvgons. This will cnable the letter Tices of
the text te be defnrmed along the surface of 1the sphere. Use the
follonwing vahoes for the subdivizion: X = 5, Y = 5. £ =0on
cach af the letlers.

m Rotate the logo 90 degrees on the x-axis and 180 degrees on
the z-axis.

m Choose Effect = Breeee + Rotation on the logo, This is
required since deformations use a different global axis.

» Choose Deformation < by Patch =+ Branch + Create on the
lesger and pick the sphere as the deforming surface,

n Translate the fext in x and 2 directions to move the Togo across
the susface of the sphere. Expeniment with scaling of the text,

n Try tagging and moving some points on the sphere. Pross the
Supra Fev rte redriw the screen and see the effec of the
surlfice modificatien.

I"- Tir The object has o be froeen before vou apply the
F '

r_|-:_'."|::-r|11:'.l FINERE

A parch surface has only two dimensions, Te move an
ohicct on a patch, von Tave w translace the object in x
andd w17 you are wsing Dragging mode (TRGT make
sure that vou transhae the abiect in the Top view,

When vir) ;IE:-'I.I:.' thi defarmation for 1the first 1ime,
the tramsformation valoes have an ollsen Srar the
translation by reserting the valoes to 0.
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podel Module

Rings

Duplicate from Animaticn

—

e v Use the Ghost view mode 10 guic kv s where the start
I F|r| = 1

380 3 square with a length of 4.

Rotate the square 90 degroes around the x-uxis.
Choose Effect = Freeze & Kotation.

Cet a B-Spline circle with 2 rading of 13 and 8 steps.

Selet the square and assign a deformation by spline wsing
Deformation - By Spline = Node + Create, and picking the
cirgle ws the deformation path.

Reset the translation of the square by elicking in the triangubn
tab in any of the Translation menu cells, Make suze all values
arc defined as D and select Set,

To animite the square, se1 the length of the tme ling 10 80
rend frame) and set the current frame (o L.

%c1 a keyframe for the square by chocsing SaveRey -+ Objec =+
Maode Spline Deformation - ALl in the Motion module,

Go 1o the Last frame. Teanslate the square iz v onl it reaches
the 5.I_:|r|i||3 |'l-.‘:-5i1i-.‘.l|'|.

Rutate the square 360 degrees around the eoadis

Feyframe all values again by clicking SaveKey with the middle
mass buting.

Change the function curves o lincar interpaolaticn.

Copy the square cross-section by choosing Duplicate + From
Animatiom on the square with a frame step of 100 Hide the
original square,

Choose Surface + Skin to connect the squares with the
- Splize and Close oplions,

Raise the resalution of the resulting patch and invert it if
TIECEFSITY.

Ry lacation is set to (instead of WIRE, select Ghost).

a1



Model Module

|

Soft-drink Can

NURES and Trimmming

a In the Model module, choaose Draw = Curve o HURES, Diraw
the profile of the can in the Front view so ot can be revolved
around the v-axis [pae the same nember of points asin Lhre
firat illusiration).

» Change the weight (W] of the corresponding, points {second
ilstration? in the Edit = Coordinates dialogoe box,

m Activate Preferences = Create Modelling Relations.

m Choose Surface =+ Bevolution. Sclect the y-axis as the rotation
axis Cdefaulch and the Cubic option under NURBS (create a
MURES nstead of polvgon abject)

m Feshape the object with relatiomal modelling. Selec ths
original NUKBS curve and wse the m key to il the position
of the podnts. Refer to a shaded Perspective view for interactive
feedback

# Choosse Effect = Freeze = }'-.-]u:.dn:]ii,ng Relations, and then chick
Ok in the dialegoe baox,

a Choose [nfo = Seleciion and close the cappeng for hath ends
af the W eclion.

m Trim a hole for the opening of the can. Choose Diriw - Cuarve
+ MURBRE. Dymw o corve as in the thivd dhesieaion in the Top
view, Choose Drraw = OpendClose and accept the delauh
eptions. Position the NUBRBE curve on top ol the soft-drink
cam using the Front view for reference.

m Select the can and choese Treaw = Trim NURRS Surfuce. Pick
the WUERS curve, specify the v-axis as the Parallel projection
method, and click Ok i the dialogue bos leaving the orher
values as they are.

P Tl I LR T O T i S
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hMade! hMaodule

Flower Power

NURBS and Instances

=

|
id

Torawe a Floseer Gace in the Frant view, In the Model merclule,
chionse Dirpw = Curve = MURES Meofer o the frst tllesizaion

Close the spling by chocsing Draw = OpendClose. Use the
el valoes.

Convert the closed spling inte a face by choosing Diraw =
Converl 1o Face.,

¢reate a picture file that will be edited with the paint ool In
the Matter module, choose Materal, Select the Constan:
!

Shading mode and make the RGB values = 1 Dwhited lor the
Lhaffuse compoent.

Position your camera perpendicular 1o the flower object and
frame your aliject in the centre of the Perspective waew, Chonse
Render, set the end frame 1o 1, give a name Lo the pacture, and
with the Filename button, specily that the file s being
rendered in the PICTURES threctory instead of the defauh
BEMDER_ PICTURES directiory.

You might want to make sure that the normals ol the
ohject are facing the camera (choose Show = Normali.

Edit the picture by choosing Texture + 2D Global. Get the
picture file, select Paine, and coleur the Nower by hand Do
RCE onlv). Save the picture and chok Accept.

Select the XY mapping method. Frame the image with the
cropping rectangle and select Cropped 1o geta bener ander
stancing of the Anal texiure image we by vsed. Chck Ok

Fine et o laege the flower s by choosing Info -+ Distance
and picking two vertices on sach edge with the lell mouse
button. Wote the distance that appears in the st bae

Create instances of the flower by chocsing Duplicate +
Instance Beperition. Enter Wo. of eoourrences as 4 anil
multiply the distance fovnd in the previcus step by 2o the X
Transhatine b,

Puplicate the instances in this Arst row 1o create a series of
ronws by choosing Duplicate = Instance Repetition. Enter 3 e
the i of socurrences and keep the same distanee, Tut this
tarme give @ negative transltion vishee i the £ box (5 =10,

L= old X ovaloe),

Select the original flower. go to frame 50, and in the Maotion
module choose Savekey = Object = Shape. Go to frame 1
Select the original lower and tag the head poeints, as 0 the
sccend lustration. Rotate the head ahout -15% on the 2o,
Choose SaveKey =+ Object + Shape agin. Go w frame 100 xnd
ratate the tagged peints zbout +13%, Choose SaveRey + (et
=+ Shape apam,

Add a floor, a sky, and animate a ight Cwath shadows over the
scene 1har Follovws 1he dower's head rotalion.

e Swap the ariginal flower object for a |::-|,||!|_|i|'|;._:.

L
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Maodal Module

Gears

Tagging, Holes, and Extrusicns

Get a Primitive Circle with a radis of 15, and step of 37,
Click on TAG maode in the mode selection menu,

Tag every other sel of two points starting at wop ol the circle
fpoints 1and 2, 5 and 6, 9 and 10, and 50 ond.

Click om the wriangular tab in the Scale rmenu cells and enner
0.75 for X and Y.

Switch 1o OB mcde.
Chase Dieaw = Convert be Face.

et a primitive circle with a radius of 3 (hat less sieps than
previously defined, such as B

5_e.||_-,_'| 1hi Qear 5P|'|_-;|_l Chness Dirase = A lt.;'ll:]'l E'IILL', then click
an ihe smaller circle.

With the Face selected, choose Sureface + Extrude, Make ita
Falvoon. and use the e-axis [defaull] with o sep ol ] and a
depth of 1. Select the Close check hox iF it isn's already active.

Wame the exeruded obpect Gearl in the Info = Selection
dialogue b,

Chense Display o Hide = Toggle Selection For the Goe of the
goar.

Choose Duplicate » Immediate for Gearl
Name the resoling abject Geard,
Tranalate Gear? 20,5 wnits o the x-axis.

Gane the scene For wse inthe Mation sectiom of Teasons,

a7



Model Module

TV Set

n
5

| Polygon Madelling

‘h‘]l [ m [1the Model modole, choose Gel = Primitive = Cube {defauh
] leergerh s 1000

. n Select a pelvgon en the culbe by choosing Polvgon = Selec

| Polvgon By Rectangle. With the lefl mouse hutton, drag a

. rectangle around the back {right side, Front view] polygon of
— the cube, Change from QB[ 1o FOL maode, then choose

| Duplicare + Immediate.

] .. - .
{4 i m Tramslate and scale the mew palyaon in the positive s-axis (firs:
"
angd second atluscrations].

m Build vour TV medel, Repen the st two steps of Duplicate -
Immaclinte and Translate tor the remaning pelvgons, MNote
that the pelvgon for the seeeen is translated imside the cule 1o
creabe the TV screen.

Re carclul to have the proper polyeon selected: use the
Perspective vigw in full screen mode anad orhin your
camera around the TV,

m Desclect the pelvgon, Choose Polvgon 4 Select Polyvion By
Hectangle and use the middle monse button o desclecr by
dragging a rectangle around the polygon.

p Level vour model by cheosing Effect « Bevel. Accept the
defaalt values (bevel 0010,

a Choose 3Material in the Maner modole, Enoer 002 for DT,
0,48 for Ambient ROGR, 230 a3 the Specalar Decay, and 0004 a5
the Retlection valus

m In the Model module, chnose Polygon = Select Polvgon By
Rectangle and select the TV screen,

s Back in Matter, choose Polygon + Assipn New Material. In the
Material editer, select Constant Shading and accep the default
values.

p Choeose Get - DB Exchange and copy an existing Thpheok in
EFWTER_PICTURE (jewel. for example) oo PICTURE file.

m Choose Texture = 200 Local, Select Sequence. and select the
flipbook thit vou just copied. Enter the correct friame range
and select the ¥E mapping method.

® Reposition the texiure sequence. In TRT mode, reduce the
seale to make it fit correctly on the “soreen” polyoon.

m Use a grid for the Moor and define a light. Render a fliphook.
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FPolygon Madelling

Choose Get = Primitive & Sphere as a Polvgon with Radios 3,
| |||'|5._1'.I:.|||-.' 14, and Latitude 16,

In the Model meduly, chose Polygon = Select Polygon by
Bectangle. In the Front window, draw a rectanple by clicking
and dragging the curser (lefl mouse buttond around the third
rove of podypons from the bottem.

I the Top window, deselect every other polvgon by cicking
and dragging with the middle moeuse botion,

Click on F‘-:_\l:.'gl'll'l rcsde (O in the mcdle selection menu.

Inn the Top window, use the Supra Rey ® 10 scale the pelvgons
wniformly until the corners losest te the contre wouch tall
three mouse buttons in XY 2 o any mcose bution in XD
Reder ter the second |'|E,'I.I|'C.

Press Supra Key v o see the Transluion manipulation
selection, Chick LCL.

Fress Supra Key ¢ o see the Botation manmipulaion selection,
Click 1.CL.

Press Supra Key x o see the Scale manipulation selection,
Click XY7.

Chocse Duplicate = Repetition i greate five occurrences with
these settings: Scaling X, Y, 7 = 075, Ratating - 15 om K. and
Translating +.00n X and ¥,

o back to O8] Mode,

{Choose Get = Frimative + Sphere, Diefine it as a Patch,
B-Spline, radius 1, and a step of § for Loagiude and Latiode.
In the Info = Selection dialoguee box, name the sphere " Eyve!”
Chonse Duplicate = Immediate, scale it smaller 1o make the
pupil. and name the new sphere " Popil.”

Fick the Pupil and choose the Faremt meno cell. Parent i
che eveball wsing the maddle mouse ooz,

Press che v Jupra Kev 1o ieanslate the eve in the proper
POsILI.

Choose Effect < Symmetey 1o duplicate the eve, and then
parrent Batl eyes 10 the body,

Save vour scene for use in the Actor section ol the lessons,

k1



pAotion Maodule

Bouncing Ball

Keyframing, Function Curves

Geta defanl grid and a B-Spling patch sphere with a radius ol
L wnit.

Activate The grid lock in the Front window using the Lavinn
icon in the window™s ttle Bar (the ele ruler won .

Change the mede te CTR {centred and translare the contre of
the sphere to its lower pole.

In the Motion module, choose SaveRey = Chhiect + Explicit
Translation te record three key positicns of the ball at frames
1,25, and 30 (refer to the imagel.

Flay back the amimation. You will noticr that the ball seems to
flosat. Ter give the ball mors buunce, edit the function curves
representing the translation of the kall Csee steps below)

Wiake sure the sphere is selected,

Choose Forvielect = Object + Explicit Translation w disple
the function cerve sditor (1he Fouree windowdand the
Nunction corve Ccarve ) attached o the sphere,

Press ihe space bar and chekoom the v Fourve [grees . Yo can
also click on the Foeeve's name (sphere Letrmy ] oo seloct il
without pressing the space bar, A selected Fourve turns while.

Choose FervEdil = Slope Management (or chok on 53LOPE in
the Fowrve window tithe bar) and click en keyvirame 23 with the
middle meuse lanon w break the slope,

Choose FervEdin =+ Edit Koy Point (or chek EDITREY in the
Fourve window title bar) and ose cae lefn maouse button Lo
adjust the sloge of the curve in and out of the key point. Play
back the animation o evilere vour changes.

="
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Your Name In 3D, Part 2

Keyframing, Rendering

Fram vour database, retriove the scene created For Your Mame
im A1 Tan 1.

Choose Camera = Reset and move yeur nase Lo the centre of
ihe Perspes nive window,

Choose Gel + Primitive » Noll and parent the Lewtess 1ogether
as children of the mell

Set the end frome af the time lne w frame 30 and move the
tianee line pointer 1o frame 3.

Save a first kevlrame by choosing SaveFey = Object =+
Translation in the Motion module,

hlowe the time line back 1o frame 1,

Move your name on the posttive @ avis tovward The canern
until it is off the screen in the Perspective window,

Save a second kevlrame by choosing Saveley » Object =
Transkitigen.

Flay hack the animation.

The path can always be edited o change the stanting or ending
position. Translation path s displayed by delault for use Path
+ Show te display the path? and vse the Supra key m o mosve
the poinis of the path.

Rercer the animatios st o resolution of SO0 x 300

IF the object 15 oul of the camera’s site, vou will seea
messitge Mo Visible Triangles” — don't worry aboat it
unless all voLT lenmes de chat!




pAotiaon BModule

Jojo the Happy Fish, Part 2

spline Deformation, Keyframing

m Ciot the soene containing vour model of Jojo Jsee Maods!
Project: lajo the Happy Fish, Fart 11

 Choose Display + Hide + Topggle Selection w hide the sea
tloor,

w In the Top window, choose Draw = Corve = Cardinal and
draw 2 path for [oio to swim aleng.

a With the middle mouse buttom, select the fish, Rotate 1he
el by =50 degrees on the woaxis (necessany in this cise o
have the deformation appear correctly .

# Choose Effect « Freeze + Rotation.

» Choose Deformation = by Spline + Brasch = Create and pick
he path (without pressing the space Barh.

& Toscale vour fish back 10 its anginal size, click on the
triamgular tal in any of the Scale menu cells. Make sure the
values are all a1 1 ad select 3ot

m Translate foje on the v-agis t rake him swim gracefully, Yo
weill murtice thas the spline path has i effect become the y-ais
fear the maoddel.

m Toocreate an animation il laajn ﬁ'.m'i|11:'_;llli'_. ke sure e Lime
line is at frame 1.

m Fring lojo back o the begimning of the path and save the fir
keyframe by chacsng SaveRey » Ohgect + Branch Spline
Deformation = Translation

a Mlove the e Tne to frame 100, translate Jojo o the end o
t.i'.l_' Il.ll:.."_. i'||'|q_I advg il 5-||.":‘i|:'.L1 I‘-:L'}"I-r-c-l-::l'-

m Plav hack the animation.

w The path can always be edited by moving it control paints.

p Save the scene for further work in the Matier Projects [ses
Sarter Project: Jojo the Happy Fish, Fare 31

" T'in_. For spline defarmation, always align the medel aleng

h “r . - - . . .

p— the v-as with the “nose” of the model pembmg ap.

anil the abject should be at the omgin. Then freeze sl
rotations before creating the deformation, Freceng, the
sealing will also prevent the ebpect Trom moving brarsiale
the path,




Motion Module

Keep Talking

Shape animation

Choose Get + Primitive « Torus and make it o B-Spline patch,
Retate the torus 90 degrees on e X-axs,

uplicate the torus theee times wsing Duoplicate = Repetition
with o translation of 20 umts along the x-axis.

Change o TAG manipulition made. Lse the Supra kevt o tag
points and madily each torus mie o diflerent meath shape: an
apen mouth, & clesed maoth, a smiling mouth, and a mire
mouth.

Change hack e Object (OB mede and selec the clesed
mcuth, Make sure that the tme line isa frame 1 and seve the
frst kew shape by choosing SaveFey = Object = Shape.

sove the time line so frame 20, and save the second key shape
b choastng, Shape + Select Key Shape and picking nne ol e
three mouths, A kew shape i automatically saved.

Tn the same fashion, save a key shape using the other twn
micudhs a frame 40 and G0,

Cie Tl 10 frame 1 and meve the 1ime hine |l-::-i|'|||.'. o frame 2
using the right mouse button - that way the soneen clires o
get refreshed. Save one last kevirame by choosing savekey =
CObject = Shape.

Plaw the animation,

i rip | Tochange the tnterpolation of the points between
e kevirames, choose Shape =+ Shape Interp.

To gt list of the dilferent shapes or delete o shape,
choose Shape =+ Shape List.

If 2 rotation is done on one of the lips, make sure to
frecse the rotation - 18 i1 i nol done, the animation

won't work properly Lall points are referen cedl by 1l
ceptre location). -

-



Matian Modaulg

Hang Ten

Wave Overview

m Choose Get = Primitive = Grid as a B-Sphne Patch wsing the
default values.

& In the Front window, teen the Grad lock option 0N and draw
4 B-Spline curve using these coordinates as control points:
=l X=-2 T=1N L=0
#2 el Y= 1 L=0
o3 =1 oo -] L=
7 K= 1 Y= 0 L0
That is. first control pointar X = -1 Y =0, L= seCirnd
control point at X = =LY =1, 5= O et

a hoose Effects + Wave - Create, In the Define Wave dilogue
T, v all the definle values and confirm by clicking Gk A
wave jeon apprears autematicall.

& Choowe Effects = Wave + Attach = Mode and pick the
primitive grid {without pressing the space harl.

u Seloct the Shade view made in the Perspactive window amd
play the animatien.

m Experiment by scaling, rotating, of translating the wave ioun
1o obtain different results.

w Experiment with other types of waves: planar, circular, and
spherical,

I"' Ti"r_. Yoa can modif point Iocations nome ically with Edin=

i . . : .
- Coordinate in the Modal mmodule.

P T N Wl - LT L 1Y S
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Waves

Crasnte g wirter surfacs by choosing Gret = Primitive = Grid.
Select a Cardinal Pacch grid.

Create a log by choosing Get = Primitive = Cylinder.

Gela null by choasing Get = Prinative = Null.

Position the lag (ovlinderd on the warer surface (patch grid)
Fotate and frocae.

'I:;l.l:-'_ a paint en 1hae 1:7'.|_| i Trasntl ol e I"H' Chocse ﬁ!l.u.p{' = et
Cluster and call it “nullconstrain”

':_:I:l]'.lEtI-JiI'l lh{' |'|'.,:” |,|_'I lh{' -;,'lusl;.,'r 'n"!ﬂ'. {:l::lrlhll.'iLirll -+ ‘.-:I.Iilj‘l.'\'.l. (1]
Cluster (select the noll and then select the grid L

Untag the first poin. and then tag a different point on the grid
uncder the Tog, Choose Shape - Set Cluster and call in
"lepconstrain.’

Constrain the Jeg e the clusser with Constraimt = Chiject o
Cluster (select the log).

Constrain the direction of the log 10 the null using Constraint

-+ ].‘-'iru-:'lln:m, Then selecl 1he 5._'_.-'.|| HEEHIR

Show the ceatre, select the log, then consteain the direction
and select the null.

Corate a wirves driw Chee profile of the wive withoa B-Spline
curve (see the second illustration ). Choose Effects = Wave =
Crepie, then select 2 planar wave, Aftach e wirve 1o the gricd
kv chogsing Eflects + Wave 4 Attach 4 Xode. baale the wave
teesn s 11 covers the whols grid surfics,

-



Mation Module

The Digestive System

Vilawes
p Cheose Get + Primitive » Circle and select B-Spline.

m D @ B-Spline curve that looks like an intestine and be sore
bo make lots of comerel poinds (use the Foont view),

§ Create a hoear cueve going Trom 2,0, Goe 0, 2,0, Moty st the
curve should be in the positive stde of the y-axis since the
negative side is only for the "after-elfeat” of a wave

An extrusion lor the intestne:
n Make sure moedelling relation is off (the defal).
m Extrude the circle along the spling.

Seale and freess the circle if necessary — 1 should be

J—
| :'."u' ' )
e abwt the sare of the illustration.,

Then a wave:
m Select the hinear curve fhe l.';.i-\.'lgcl'l-\.l.l linel.

§ Choose Fifects + Wave < Create, Select the sphertcal tvpe ol
wiave and set the velociy 1wl

w With the wive 1oom selected, choose Effects + Wave 2 Actach
= Woede and click on the extrosion Jimoestine),

a With the wave icen sill selected, choose Path = Pick Path and
click on the nriginal spline (the intestine profile!. Click % in
the dialogoe bax,

Then tweak:

s With the wave icomn selected, choose FervSeleot + Wave =
Drecay. Make that fourve Mata | on the v-asis [Hhree points b
defaultl, Remove the two zero key poimnls.

m Flay Tack the animatien
1 Tl'p } Uy bo pat L witves G0 the samse 'i'll.'l_ll.""-\.t
Try to play with the scaling, and key .
[f vou have the custem effect Draw -+ Curves -

Resarnple +. wse it on the intestine profile curve before

pxtruding.

EFETIE S A s 0 A e e b
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m Accept the setup by clicking Ok Pick the s:

ereTid A0F 371 wirkboes

Flock Overview, Material Animation

m Chocse Get = Primitive = Sphere and choose & Folygon with a

Radius nf .

Choose Duplicate » Tmmediate, Scale the duplicate sphere by
a Bactor af & 1imes on all three axes,

= Choose Get 4+ Primitive + Cone using the default values.

eale the Cone to 0,2 units on all three azes

Chonse Efect + Freeze + Scaling in the Model madule,

m Make sure the time Jing 15 at feame 1, Choose Material =o1he

Satter medule, The Material Eduor dialogue hox appears

s Lamtbert shading anil ke the l:l':\-_l-;_'nl vellony by :.I:-.:-1§:.':i|'|:.;
2 vilue of 1 oo both Hed and Green, and a valug of 0 fo Blue,
Save 2 material keyirame by clicking om the Key butten

= .l"-1-::l'|'-;,' 1|1'R.' 'uil'l'll:' |i|-||_'\- %) '_'1';|_| e | F| :\.1,1}:';' 1]'!!.' l."!.lili ol Tl_'-C..:I a'l'l'.l.l :'.I |-

transparent. Save 2 second keylrnme.

Choose Effects » Flock Animation in the Metion medule. In
the Flack aonimation 'Ii;l'lilgl'lf b Lhin APELars l_'-C._:|'.| -\.:-I'Il':' L=
]:l:lh.’l‘."‘.‘.ﬂ{'r'.-:

Mumber of Faricles: Al
Drestination Scod; 45
atop Framd: L5
Repetition: 3
Frame OfTset i
Seod Offaen k!
Flicde Belore Start; M

Interpolate Materials: O

I aphere as the
Source abject, the larger sphere as the Destination abject, amd
the cone as the Particle abject. SOFTIMAGE 30 will then
prnerate the number of eepetitions specified.

m Plav back the animalion and render a small lipbook.

} Tiefore rendering bide the owo spheres.
Seare : ;



rotion Module

sliding Blob

Lattice Deformation, Keyframing

Gl 3 B-Spline Patch sphere with a radhws of 1 onit and a cube
of lenpth 4.

Scale the cube up by a factor of 3 on the yeaxs.
Make the cube the parent of the sphers,

Agsign a hranch lattice to the hiera rchy by using Lattice -
Eranch = Create with a Curveanterpolation. Using 2 Curve
interpolation will let you achieve a smoother deformation
when animaging the laitice and the sphere

Change 10 TAG manipulation mode and ransiorm thier contral
points by wsing the Supra Key 1 e tag points on the Lt
This will deform kgl the sphere and the cube. Use the
iNustration as o basic reference for tagging, scaling, translauing,
T |1I:|5_:5i|15. (o

Press the space bar wlile selecting the cobe, and make 0
invisible by using Display + Hide + Togale Selection.

Solect the sphere and animate ite position aling the v-axs by
saving twe keylrames with SaveKey + Object = Explica
Translatiomn.

Play back vour animation and render a small dipboak

To add animatien o the lattice Bsell, use Display » Hide »
Unhide All oo shoow the latice.

Seleet the lattice as o lranch using the middle mouse buton
while pressing 1he space bar,

Yexun cin Lhen 1ag |_'u:'|i|'|1_'= an the Lattice and create kevirames by
wsing SaveKey + Ohject + Branch Lattice.

Play back yeur animation and rendes a small flipheok.

Il.-'l"l'll'!' Lattice animeation allews vou to animale the shape of
! the lattice and therefore add the anizated deformation

1o any object included inthe Lattice, For example. vou
could create bubbles rising Mrom a sea oor by
animating a group of sprheres and vsing latice
animration 10 add the effect of water currenis,

CPIETIE S Aol 771 Ve e




Mation Module

City 1

Camera, Path Animation

B Create ten cubwes and a simple grid W credre a cityscape
m Draw a Cardinal spline path that goes threugh the oty
m Change the end frame of the time line w 300 frames.

m To show the camera, chocse Display -» Hidde = Unilide All o1
rinake e of The win o wiews o Schemmiic view, Lolect the
Camera obiect i the Front view or the node called Cameral in
the Schematic view, You can also select the camera by chovsing
Camera = Select Camera.

a Animate the camera along the path by choosing Path =+ Pick
Path in the Motion module and picking the sphne path.
Accept the default values by clicking Ok

m Play hack the aramation, Yo will motice that the carmer s
following the path, but the camera interest slivs fined.

m To animate the carmera’s point el mterest on the same path,
select the node called cam_intt inthe Schematio vicw:

& Choose Bath =+ Pick Path and pack the spline paih again. This
tirme, change the values te startat frame - 20 and end at frinme
280,

m Play back the animation. The camera mteiest is now travelling
along the path shghily alead of the camera el

| T'f,l"_ T see mare of the ity scene while Treay the camera,
choose Camera = Settings to increase the Camers Lens
- Custorn angle (Field af Wiew? serting of the lons, o

LTEEasT i-;.:}:.' sot this b = :-:1:::i||;._'_ in the '|:'-'."'.'.‘~['ll."-.".i'-' LR [
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PMotion Module

City 2

Channels

Use the city scens and camera path vou ereated inthe Tty |

I EhbilIL.

Sake sure the camers and the camera interest are armated
alomyy the patk.

Choose Channel + Channel Setup. There shocld be an actiee
mouse driver with two channels, one for the % positinn and
anther for the v-position, Click Ok wo accept the seilings

Chonse Camera = Select Cameri,

Choase Chanmel = Conoeation Setup and select the CAak]
Cameral.corrs function corve and the CHN L mousexpos
channel. Select the -> Connect -3 button to set the
connection. Enter 100 in the Scahag text box and then chok
ok

Open the Conmection Seiop dialogoe box agasn., Now selee
the CAM Cameralommitrs function cueve and the CHEN |
mouse xpos chinnel, Select the - Connest <= oo o5
the connection. Enter 100 the Scaling text bok and 3 0 the
OfTset text box., Click Ok 10 Anish the setup,

Fnlirge the Perspective view and choose Channel + Caprores
Control = Frame 10, Az vou mave the moeuse from el mn
right, the camera will travel alomg the path. Click the righe
mose butken Looexet the Frame 10 muode,

In Multi rmode, choose the Belect = Al commind,

You can also create an animation by capturing maotion through
channels. Make sure the corrent frame i se1 10 1 and choose
Channel + Capture/Control & Sequence 140,

Click che left mouse buitomn 1 start the coontdown, Al the
beep, vom can st moving the camera along the path. A
Funccicn curve will automatcally be recended as long as the
time line poimter 35 moving,

Play back the animation. You can view the Tunction curves by

choosing FervSelect = Camera + Position or Fe rrielect <
Cameri = [ncerest.

by eonnecting the cmroll function curve with the
mouse.vpes channel, Since it can e ditheult te contral
Lotk poaition and roll at the same time, youo should
animate these two parametens one aher the ether

I-" Tin You could also Lxperimenl with the rall of the camera
e i

Choose Effect = Alignement o make all the buildings
Mush with the "ground.” or meve the centre of 1he i
cube e the Bestterm af the alyect hefore duplication,

N el I Tl el T =" B TT e o S,



tAction Module

Bla bla bla...

[ B ] Channels
S - o s Choow Ger + Primitive « Sphere as a Polvgon using the
e R FEEY defauli values,

a Choeoss EMfect + Plane Clipping in the Model module. Ths
- o _ cuts the upper half of the sphere above the x-axis.

m Inthe Lavout dialogue box, activate the Grid Lock option.

i m In Centre (CTHRI manipelation mode, move the centre of the

) hesmisphere 5 units in negative 7. The centre should now Be an

— ; the right side of the hemisphere, Deastivate the Grid Lock
IR

a o back ta Chaect TORD mode and choose Duplicate =
Bepetition 1o duplicate and rotate the hemisphere. et ihe
duplicate number 16 1, and 180 degress arownd the x-axis.

g Choose Effect + Freeze 4+ Rotation

w Create the eyves of the character then assemble 2 hierarchy
where the upper hemsphere is parent of both eves.

& Choose Get =+ Primitive =+ Mull and make i the parene of the
top and bottom half of yvour characee.

m Select the wpper hemisphon: as a branch and choose Channcl
= Connection Sciup in the Motien modole.

n Connect the sphere rots function curve with the CHM
T 582 X 4 hansel, Set che scaling 1o 30,

w Select the botam hemisphere and chovse Channel <

Conneciion Sctup

w Connest the sphere oot lunction curve « ith b CHMN T
M USE K05 10 channel. 5ot the soaling, o ML
m Sclect the entire hierarchy asa oree.
8 Choose Channel = Caprore!Contral = Brame O and move
the mouse horizentally wanimae the character inleractively.
m Tor record vour antmation, make sure the time [ pesiter s an

frame 1 and cheose Channel = Capture/Control &+ Sequence
1M,

P T ] & DTN T A 7o
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Expressing the Gears

Expressions

m Gl the Gears seene created inthe Model section, and then in
the Mation meduale, select the object called Gear2,

m Lhonse F:-:[lr-&ﬁ.iii‘.ltﬁ =+ Edit.

m [ the Fxpression Editor, the meme of the Affected Element
appears followed Ty a pesiod L1

s Click on the Fourves button to acoess the foarves 10 be affecned.
Chick o roaz, then chek Ok

m Click in the Exprescion et box,

& Click on the Sen Flements bottom and select Gearl from the
liar.

m Using the Fewrves button again. assgn e s01x cxpression,

m Click at the beginning of the line and type a dash (-1 fellowed
e @ spage.

w Click Validare, 1hen Ok,
# Select Gearl and rotate it on the -axs,
m T effaet Gear?, select it amd choose Expressions = Edit

n Atthe end of the Expression line, tepe - 12, Click Validie,
aml then Ok,

m Agein, select Gearl and rotatg it on the z-axis.

2l 5 BT P [ S




Mation Moduls

The Meter

Exprassions

m Gel four simple cones, Flace one at 0,0, Q, and place the
second one at 10,00, Call these mwo comes “Borderl™ and
"harder2™ Place the third one a1 5,6, &, and name it “sheep.”

Take the fourth, rotate it by 180 in the w-axis, mone 18 e 5, 10,

0, an<d mame i "lead”
Wlake sure to name the cones cotrectly hecause

T
| Ti : .
CHED TSRS ATE CasC SCNEIET
Solect the cone named “sheep” and then choose Expressions =
Edit in the Motion module. [n the Affected Element toxt heos,

.
vou will see the name of vour abject followed by a period ).

sen click on the Fourves Butoen and select the etrna Fourvs
This will tell SOFTIMAGE 310 that vou want the expression Lo

modify the movement of the sheep on its explicin translatien

for she s-axs.
[0 the Local Variables section, there ane four text boxes:
- 1in the A text box, type pozderl etrnx

< I the B otext box, tvpe borderd , ebenx
I othee 7 mext box, tepe 1ead . obonx

m In the Expression tex box, tepe the followmg:

atad s LN Rar N R I |

o
T

ool Ce=h EE O o« B,
This cormmand liste can ke read as @ stendacd

el IE THEN ELSE™ statement.

w Click on the Walidate botion., If the expression isvalid,

clhick Ok,
m Animate the lead - move 1he border.

a2
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Flex 1

Revolution and Chains

Tis v the lessomn. you need two oljects: a muscle and a bone
streciure. The muscle is @ basic patch deformed by a lattee, and
ihe bane siroenere is, of course, @ skeleton.

» The muscle is created using a revelution oz & spline, Use the
Revolution dialogue box to create your muscle wsing the
wonxis. The centee of the muscle should be anan extremity

m The muscle should be areund 7 units leng and have a radhus of
.5 units, Rename vour muscle "muoscle”

g Eor the bone, create a three-joint skeleton thal relaes o vour
muscle,

COETIE S AmE 30 ALk e
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Flex 2

Expressions

w You now need toocreate o bcice an vour muscle. Refer wo the
three pictures here 1o create a lattice animation using a defl,
node lattice. The pictures relate o frame 1. frame 50, and
frames 145,




hiction Module

Flex 3

Expressions

Place yeur muscle around half way of the first jomt and make
it a child of that joim (il _1 ) You may need o rotate the
mesele a it

Select the Muscle abject and choese Expressions + Edit. Enler
the following expressions, use the Validate, Fourve, and Sen
Elerment buttons 10 speed up vour process and rethuce vour
s [=ic).

Toenter several expressions for the same object, vou neel 1o
use the BMexi button,

ELEMENTS EXPRESSIONE

hluscle.solx il _Zorarz £ 2

plusclescalx 1 -0 abst mel_2oeiz 171800
Musele Irnade mll_2eonz S 70

Refer to the Schematic view to verily the joint names.

® Now assipn an expression for the colowr of 1the muscle. To da

s, give the object a colour... o nice pale blug will e,
Diffuse B 0.7

[niTose G- 0LR3

Dhiftuse 15 043

Onee the materizl & given, in the Schermatic view i Mater
mode, select the material traperoid of the muscle. Choose
Expressions = Edit, and cnter this sel of expressions:

ELEMENTS EXPRESSI0MNS
Muscle.mtdifg LA el 2otz 4 180
blusclentdif 1.0 - ne]l _Zorestx & 1ED

m Use the Cope and Paste butions e copy 1he expression,

HAG
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La Fontaine de Jm_.lﬂ_uence, Part 1

A Pixel-based Particle System

m [n the Particle program, set the End frame e 9999 (o that the
plavback keeps poingl.

Select the Source moduale and remme the Sooree abiecl o

"
]
# Adiust the Spreacd se 3.0

|F'I'?-_|‘.I } Make sure to press Enter after typing iz all values within

Farticle, or they might not get accepred
o Adjust the Speed 10 6.0

m Select Color and set the color to a ight Blue: Re0.2, G=05,
B=1.0, A=1.0

B Activate the Color shifr
m 5ot the Color to pure white: B=1, G=1, B=1, A=1
m Add a Gravity field by pressing F9, and ser the 3trength o3

# Select the Eile moadule and Setop, and deactivate tha Dhspeley
grul.

Acid a new obstacle

a Sclect the Obstacle moduole, then select Mew and pive 2 name
10 1he new ohatacle such as “hrse”

m Scale the SOUAEL obstacle e X=12, %=1, Z=12.

m Position the SOUARE obstacle o X=0,% -1, Z=0, Make sure
that the ¥ position is negative 1 0-11, so that it s below the
EOLLICE.

n Play back the sequence: at this point the particles should he
emanted from the Source and bounce off the square ahstacle
'n']]l_l{' 1|1;' n;-:_'-l-:_'.r -:_|1:'.r|5-e'5. from blue 1 whine,

Copy Lhe previcus particle and change its color
m Select the Particle module and renamie the Parncle O "PLT
m Zelect Copy and rename Partacle_L o "FLT

B Eemove the Color shil and set the color to white: B=1, 4G=1,
B=1, A=1




Maotion Module

LETik 4 S =E 5 Wi bl

La Fontaine, Pa_rt 2

Particles
St 1he decay parameters

m [ 1he Scurce module, under the Particle subsection, selea
Dhecay,

m I the Decay Parameters dialoguse bos, select Addd,
m Select P2 and then Ok
m Set the Mumber 1o 3, set 1the Speed to 2, and chick Ok

# Sclect the Source module again and the New botton. Rename
the mew Source to 527

n Adjust the Rate 1o 40, the Spread to 0,03, and the Speed 1o 7.0,

m Ulse B oas the Particle,

m Play back the sequence: bwe streams should be created
Preview with a fipback

s Choose File = Bender.

[ ] _-‘|.|:|_il.|_kl_ e end frame 1o |50,

] pTL"a'il."ﬂ'.

Tender to disk

[ vou have time, render the sequence of images to vine
latshase.

L]



Metinn Module

Alien Invasion

Direction Constraint

i T The Direction constraing always constrzing an oliec

Tor create chis scene, vou need onge inter-stellar T- 207 pwin
tarrlaes LR sanel foor HX- 1R [reae abolic anoennas,

Inn the Frant vicw window, create the UFO from a simyple

]3-5}1]|_n-'_' ann:l ;_'|'||_'n;:-w 1|1|: Surf;:n.-e' = Revolution command.

In the Front view window, ceeate the parabolic dish from a
simple B-spline and use Surface » Revelution again.

Choose Gog = Primitive = Cylinder and Sphere 1o create the
TECETVING Anlenm on a pale,

Creare a logical hicrarchy so the dish is parent of the receiving
artenri and the pale is parent of everything,

In Centee [CTR ) mode, rotate the centre of the dish 90 degrees
on the r-axis so thal the x-axis Tred ) becormes parallel (o the
ECEIvIng antenn.

Choose Dupli-:a_t:: -+ ]-'!_l:p::iitiun aned ks twn Corpieca with a
Tramslatien ol =25 wits on the z2-axis.

Ytk 1he middle mouse button, select the dish of one of the
parabaolic antennas,

Clhoose Constraint + Direction in the Matien module, and
pick the UFC The dish and the recerving amtenna shoold now
b poznting towand the UTFC.

HL"FI-.".'I'! the same I.'l!'!‘l'.']':].[i.l.'l ns on e other two antenmas

In Shade mede, move the UFD in spacse

using ils x-axis, s0 the centre of the object needs to be
orienoed properly.

FrrTIiEE2 S0 == vdleal b
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Wwhat's the Matter? Part 1

Matter Overview

Choose Get - Primitive + Sphere and make it a Polygon with
o Teadius of 3 units. Use Effect + Plane Clipping 1o cut the
sphere, Rotate the hemisphers 180 degrees and move tup by
FETES

Choose Get = Primitive =+ Cylinder with a Radios of 0.5 units.
Translate the cylinder up by 3 units, Duplicate the cvlinder amd
seale it by 4 on the x and z-axes, and by 0.2 aleng the y axis.
Translate it down te form the base of your lamp,

ke ane of the ovlinders the parent of the other cylinder

Finish the scenc by adding a table and several eljects on the
1abile, such as the wine glass created in Model projecs.

Place a light inside the hemisphere by using Ligtit =+ Drefine
and specifying a Posat light type with Bayiraced shadows.

Preview the scene by using Freview = All in the Matier
maduls.

Select 1he cvlinders as a tree and choose the Mlarerial menu cell
1o apen the Material Editor. Change the Shading Model wo
Blinn and the Diffse colour values to Bed = 0, Green = U, and
Blue = 0.7, Select the Ambicnt coleur aption and change sl
colour values w2, [Inerease Reflecrivity o 08 and clhick Ok e
confirm all the settings and exit the Material Ldito.

Proview the scene by using Preview =+ All You will see that the
larnp now has o chrome base.

Select the hermisphere and open the Material Editoz. Change
the Shading Model 1 Constant and the Diffuse coloar vilues
w Bed = 1. Green = 1, and Blue = 0.8, Se1 the Transparendy te
0.1 and click Ok 1o condirm all the setings aned exit the
Marerial Editor.

Select the wine glass and change it material to Phong w ith a
Llack Diffuse colove. Set the Reflectivity to (L5, the
Transparency to 0.8, and the Refractviey 10 1.2

Wwith the help of the Material Edior, dehne new marerials
for other oliects in the scene. Preview the scene by wsing
Proview + All

Save the scene fon use in other projects,

L NI g N 1 ol I By
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What's the Matter? Par_t_z

Rendering Techniques

Mot

Retrieve the scenc used in Fart 1 ol this project.

Add a Spot light with Rovtraced shadows and HLS values of
0.5, 0,3, anl 0.3, Translate the light 1o position 3, 25, 5.

Tor sew the projected cane of hght, use Show + Cone.

Choose Get -+ Primitive = Square. Scale the square into o thin
herizontal rectangle and then vse Effect = Freece » Scaling in
the Madel module on the rectangle.

Choose Dieaw = Convert 1o Face on the rectangls

Druplicats the rectangle eight or ten times anid vse Parent 10
group all the copies o the original rectangle. You will wse the
growped recrangles as a Venetian blind olject.

Mawe the Venetian blind o position 3, &, & and rotate it by =50
degrees on the x-axic and 15 degrees on the y-aos,

To prevent the Venetian blind from obscuring part of the
scene, choose Material in the Matter module and change the
Shading Maodel to Shadow Object. This will allow the ohject 1
b Envisible but still cost  shadow.

In a higrarchy, a child that doesn’t have o materal
autornatically inherits the parem’s marerial,

® Preview the scene by choosing Preview =+ All

m Tovereate a simple environment for vour mbletop masterpiess.

chaase Got = Primitive 5 Cobe with a length of 80 wnins and
vse Eifect = Toveese in the Model modale o reverse the
surface normals of e cuabee wsvards 1he interier.

Choose the Material menu cell to change the Shading Model
e Lambert and assign o colour we che cube,

To render a final image, choose the Render menu cgll and click
the Render Sequence butien

When the rendering is complete, you can view the image by
choosing Picture in the Teols module, and selecting the name
af the file. Click the Display utton to show the selectad image
amel EXIT o leave the View Pictures dialogus Do,

10%



Matter Module

Jojo the Happy Fish, Part 3

Atmospheric Effects

Retrieve the scene used in Part 2 of this project.

Mssign surface materzals 1o 1he sea floor and o cach
component of the Fish,

Add a Spont light with Soft shadows, colour values of L5, 1, 1
& Cone Angle of 50 degrees, and a Spread Angle of 15 degrevs
Tramslae the light to position 10, 50, 1.

To create the effect of muorky waters vou will vse depih-tading.
but you musl fiest determine the appropriate distance for the
fading effect.

Choose Camera + Show Camera te display the camera,

Choose Tnfo = Distance and wuse 1he middle mouse butlon in
the Top window o click near the camera and then near Jojo.
The status line will display the distance between the two
points. You should abtain a distance of approsmately 50
umits, You want the depth-fading effect o start between the
camera and Jojo, and to end between Jojo and the T edge of
the sea Moo,

Chonse Atmaosphere =+ Depth-Fading in the Matter module 1o
open the dialogue o, Activate the Depnh-Tading check box,
Se1 the Starting Distance and the Ending Distance (hnd the
right distance using Info + Distance]. Chinge 1the colour
varlues 1o 0, 0.5, 0.4, and click Ok o confirm vour seltings.

hoose Preview =+ All o see the depth-fading effect talick the
middle uten to exit the preview],

To enhance the underwater effect, vae Armasphere =
Ambience and set the ambient light to a dark blue colaur.,

Use the defawh material on Jopa's bady, sl then assign a 200
Global texture of bump-mediom. This is feund i the
SI_MATERIALS database under BUMPS. Using the Scleci
button beside the 21 Tewture text box will call np bath the
pichure and its set parameters. Change the Hepeats o Lxl
instead of the 2x2 saved with the texiore. 3ot the Mapping
pethndd 10 UV Coardinates.

Click the Paim botton, then Smmear and Wask the texiure (use
an appropristely large brosh sizel, When you're happy with
image, click Ok i the 20 Texture dialegue box, and save the
new nap Leave oot the prefix and simply call the map " jojo.
11 wwill ke saved in the delauh database in che PICTURES
chapier.

the

Chinge from OE] mode to TXT mode and translane the
iexiure (Trans® menu cell] o that the red seam is at the tepor
Bt ol The fishe

Fencler & lphoak.,

-~
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Your Name in 3D, Part 3

Bump Mapping

m Choose Get = Text and =elect 2 Font, In the Text hox, tvpe

vour first name. Select Ok 1o confirm the text entry.

Lise Camnera -+ Reset to realign the camera, Move pour name o
the centre of the Perspective window,

Choose Material in the Mater module, and change the
Shacting Model 1o Constant and the celour w pure while.

Tender an image of the sceng with a resolution of 300 x 300
pixels. Tou will use the rendered tmage as a lextore map.

T vase & picruee file as a map, the file muose frst be moved framn
the BEMNDERED_PICTURES directary 1o the PICTURES
directory. Use Get + DB Exchange to copy of move your
irmapgs,

Chonge Ger =+ Primitive = Sphere as 2 B-Spline paich.

Chonse Material and chanig the colowr of the sphere, Choose
Texture = 21 Global and click on the Select hutton next 1o the
Picture Filename text box, In the Database dialogoe bax, selec
vor picture (e and click Load. The pieture will be displived
1z 1 Enage b,

Click the Preview butlon 1o see the wextore map applied te the
sphere. The picture is now applied as a colour map thereby
changing the surface colour of the sphere.

it =
To use the picture as o bomp map instead, change the Overall
Blending 100 and increase the Roughness value o 1
Click Peeview and vou will zee vour name embossed on the
sphere, Experiment with different values of Roughness
Select Ok 1o confirm the texture map setlings.
Add a light with Eay Traced shadows (Light + Define).
Create 2 short amimation of the sphere turning and rengder o
Mipheok. You will netice that the embossing effect of bump

mapping is 2 rendering trick only: it does not modify the
actual surface of the underlving ebject’s grometsy.

+f17
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Depth of Field

mental ray

Currenthy, the F-Stop values don L enrrespond o sactly Lo g real
35 camera, However, the three automatic vales ar e all
comabined 10 determine the depth of ficld “lenk.”

As with 1eal lenses, the shorter the focal length, the greater the
depth of feld, and vice versa. smaller F-3top values vield a more
pronouaced out-of focus effect. The defaul of 5.6 would be fine
for & real lens, bt for our purpases, try starting with L0 os (A
instcad,

The mental ray rendered result is based o a traditional pinhele

camcra, as nppased to the SOFTIMAGE rendeser which vaes a
posst - processing 1y pe of effect.

m Create 3 simple scone, or gei a previows scene That seems
apprepriate such as lojo the Happy Fist, Part 3

m Select the camera and choose Camera 4 Settings. In the
dialogue hos, set the Tocal length o 400 and the F-Stop o .25,

g Make sure the camera is visthle and chonse Tnfo = Dhstance.

a Click on the carmera ileft mouse buttend, and then @ mid-
point in the sceng [middle mouse button ),

p Erter this value in the Distance text box of the Camera
Settings dialogue hox (the value is displaved in the status line ).

s In the Render Setup dialogue box, change the Rendering 1vpe
fram SOFTIMAGE Renderer to mental say,

Chanpe the Antialasing valoces o Ak Sample 0f &

Tender a few frames from the sequence 1o see the effect at

differen “depths”

| Mot The custom values far the camera bens should e used

Sl — -y " .
anly for the SOFTIMALE genderer, and the automan

wplues by mental ray.

-"-.“rl; Modify the rayhosts Tile 1o resder en moud Leiple

L_'V] machinesfCPUs, and increase the Max samples value 1o
an least 4 or 5 (preferably 6 or higher) when vou have
samne pleasing distance and F-Step values,

Fileering: The system will amtamatically set the Min
Sample o a value of a1 leasi a difference af 2 with
respect to the Max sample, o the minimuwm Ain
sample in this case would be 1 iMax a3 1 he
command hse will reflect thar fact,

20 wdiork nonak 1A
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Motion B_Iur

mental ray

You need 1o muke a few modifications to any madel en which
won want to have motion blue Each model has a motion blur Nag
that is 5ot in the Info = Sclection dial o Tt Insicle thar
dialague box, click the Render Setup buttan. Thers are three
check boxes in the dialogue box 1hat appears, and by defaul:
every new obicer is set to Mone, This needs 1o be changed o
Lineir nr Exaci,

m et two primitives: a defaeh Dodecahedson amd an
lcosahedron.

» 5{'|.L'l.'l ihe J.':'L'l'ﬁl-"'-' ahedron -\'.'|:||-1 choose |_'!-I_1-::-|£:.'|.|'| + i |'|1il.'. lick
Ok i the dialogus box 1o confirm the defavlt parameters,
which will create a union between these vao abjects.

m Chooss Display = Hide + Hide Unselected.

s Chense Palvgon = Automatic Colourize in the Matter
madule,

w Modifv the individozl raterial valves e yvour liking —at leass
change cach coler to Lambeet shading msiead of Phany.

w Select the jewel and choose the Info =+ Selection cornmazd e
open the Palygon Tnfo dlalogue hos. Changge the Ao

Triscomtinuity value to 44, then click the Render betup butten

and change the Motien Blur option to Exacl mstead of None.

w I 1he Tender Setup dialogue box {choose the Render menu
cellh, activite the Mation Blur aption. In the Motien Blur
dialogeee box, click Active, and set the Shutter Speed s walug 10 1.
Fern will deactivate the blur effect. Mid-range values might be
desired if the blur is too dramatic.

» Change the Star frame 1o 2ero. and the Esud frame 1o 30

m Spin the abject: save a Rotation keyframe at frame 0, then go
pr Tearme 30 amul eorate the objeo 0, 720, 180,

u Render the sequence with a resolution of at lease 200 pixels.

= et the Antialiasing Max Samples to at least 3 Valoes ol 2or
even 1 will work, but the resolt is quite coarse and probably
waon't loak very realistic,

rm ] The first Mrae is never blorred,

The shutter speed is ahways Lirame rate, or by defaul
1730uh af 2 second when the shuter value s st e L

The 3FTIMAGE motion bler wses a geometry
replicaticn and transparency methed, which doasn
ilwirys give desireable resu 5=




1

Matier Module

S5oft Shadows

mental ray

To alnain nice soft edge shadows, you will use atea hight sources
thar can |.'I|'||_:|' be ],:-|,1'i:'.l OF ApR0L-Ty ligh':i I.|1:|.'.=\.|.'|'|'.'|'-':.

& Build a few culies as seen in the first dluscration on the Lefi,

# Liefine a regular point light and accept the defachis (no
shadiows ],

 Diefine another light, but make this one a spot light, and selec
the Area Light check hox. Select Rayeraced as the Shadows
Tarpe, and then set 2 low Umbra Inensity value such as 0.1

» For the first few tests, vou can leave the Area Sampling ar the
default of 3, IF you're feeling a bit impatien, drop that down to
1 or Zandfor decrease the preview size.

» Move the spot interest o the lacation in the illustration, bt
try 1o have an oblique angle to exemplity the effect of the saft
edges.

m Oricnt the regular point light off to the left — apposite the spot
light to give some ambient light to the rest of the sene.

The nice thing about the area light sources 15 the separate
sampling values. so the sampling level of the whale scene doesat
need to be as high for high-quality renders, The example image
c\-n'l::' hans o Max filter of 2, but has & Tor the liaght.

|r-'1"-'r.-} Tey rendering the same scene with the various filier
]

efferts (boxfirianglefCanssian) and compare the results.

A low filer light samphing value might be desired even
for fimal rendering, which creates an imteresting stippled
Look,

Mender the same scene with the SOFTIMAGE rendere
and the mental ray renderer and compire the resalts for
fun!




fatter Module

Fish Eye

mental ray
Get 3 previously defined scene such as Jopo the Happy st Par
4 This isn't an effect vou would use every day, but fun o
n:-_:-;'|_‘-uri11'||.'|'|'. wWith,
m Inthe Camera = Settings dialogue box, add the fisheye lens
shader 1o 1he List.
- I the Lens Shader area, click on the Select bution.
- Govup one direetory level, choose the 51 _Shader_Lib
database, and then pick 1he *Asheve” shader.

The fisheye shader should appear in the list and be active.

m Set 1he preview o mental ray, and preview the effect.

(i | Create a landseaps horizon fine and have objecss move
P '

roweard the camera, or scross the feld of view (above
and helow the harizon) to see the distortion effects.

Yo could look a1 the Edit dialogue box. aned read ahour
the effecr ([afo button |, but there s’ much point m
madifying the factor value, The Factor number just acts
like & woem oF magnification o e fsheve effect, so
Leave it at ghe defaulo 1.0,

115



Matier Module

Displacement Mapping

mental ray

The eriginal idea behind displacement mappinj, was o sy’
create wopographical information in 31k maie we don’t Tave a
cool topepraphical map 10 show you, how abeut some kbl e
'-l\.']'.\_l.|:15I

Get & primitive MURES or Patch grid.
Applya Larmberi-shaded material.

Assign a global 2D exture “bomp 1" which can be found inthe
51_MATERIALS system database under BU MP3.

Set Alpha Channel Mask as the Blending choive.

Lier zern for both the Ambicnt and Diffuse values so that anly
the alpha information will be derived from the current map.

Select X7 Coordinates as the mapping method.

Sel the Roughness slider value o approximalely 1 anel select
the Displacement (mr) check boe immediately alwee it Mol
that in mental ray, this value is how many “units” the objec
will be displaced.

Increase the map repelitions.

Set the preview 1o menial Tay, and preview the effect,

This Looks a kit tea crude, so change the valees within Info =
5{"'.":“-”“- .II'IE:Id{' 1'|-”- F‘..l':'l'l'dl."'r '_'-,,_l1 |_||;| (ii_ﬂll:‘-i_'\.ul_" |_1|;'|:v:| i.'l.'l .'||'|F|_I I:';-;,.
Adaptive setting from the defaul 5 to 2, and select prxels as the
units 1o be used.

Preview again,

Add 2 shadow casting light and render to see that the geomelry
r{“al’_:.' has been maodifed. Tnersasse 1he ]:'i.s-['ll..lt.':."-'.'.l.'l'lli valug
quite a bit higher to 5 or 10, and watch the craziness!

provides mamerous ways W determine surface
resolution on patch ehjccts, This might also be
translated o polygon mesh objecis in lulure versione.

( T'i;] Depending on the quality level you want, mental ray
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Matter Module

Ihe Asteroid

mental ray
s Cict a patch sphere and make it 2 steps by 4 steps,

» In the lnfo o Selection dialogue box, click the Render Setup
butten. Change the Surface Approgimation o Spatizl, keep the

delault value of 5, and select Pixel lenpth te define the PELIES
Click k% in both dialogue boxes.

& Crive iy asteroid a E._ar|||'|q_"'| t-tha (Iq‘l_l II'I.’I'.I\.l'i-\.'II..

a Open the 20 texture global dialogue hox. In the Picture
libsrary, nmder the SURFACES directory, select the mann
pisiure.

& Make the mapping methed UV instead of XY Coordinates.

a Select the Displacement {mz) option ahove the Roughness
dider. Adjust the roughness 1o 0.5, and accept the lextur

n Open the Render Setup dialogae bos. Select the mental iy
renderer type and render frame 1

:’_ﬁg Trv to play with the roughness.

Add an area lighi,
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Happy Sweeper

Actar Module

Caonstraints, Inverse Kinematics

—

Creats a simple characier and 2 hroom by using primitive
olsjects.

Chooee Skeleton = Draw 20 Chain in the Actor module jo
ke 1w arme. Click the right mouse bution 10 end the chain
drawing operaliomn.

Make the arms children of the body by using the Parent menu
cell.

Chocse Geg =+ Primitive = Noll and add owo nulls o the
handle of the broom, The twe nulls should be children of the
hroom. The aulls will define the position of the hands on the
laraacan.

select the effector of one of the arms. The effector is the small
cross o Clike a null) at the end of an articulated chain, Press
the space bar and use the left mouse button 1o select at.

Lee Constraint 4 Pasition 1o constrain the effecior of the arm
16 ane of the nulls on the broom, Bepeat this procedure with
the other effector.

Mow select the handle of the broom with the muddle mouse
burion and tramslate it You will notice thar the arms ahaeays
bl the hroom or try 1o reach for it i it moves 100 far away

Creare an animation by saving kevitames for the broom, Lse
SaveKey » Object » Explicit Translation in the Moetion
medule to dothis,

Play back the animation.

Teset the hroam's animation.

I -J.-J,: Create an animation wang channels, Conmect the
F

rotation and the explicit translation function curves of
1he broom 1o 1he sroase.

T ]




Actar Moduls

el el | K BN = |

ST B LT N - .

Wind Chime

skeletons, Special Cantrols, Simulation

a Choase Skeleton = Draw 21 Chain in the Actor module amd

eroate o chain of four joints in the Front view.

Get a primitive cube using the defanl values, Scale, translae,
and rotate the cube 1o position it over the first joint of the
chunim.

Druplicate the cube twice and move each copy over a foint.

Ciet a primitive sphere as a polygon mesh. Scale and meve the
sphere over the fourth joint.

Make every joint paren of their respective obsject.

Salect the chain with the middle rmose Tuen and apply a
default gravity factor by using Dynamics = Physical
Froperties. Confirm by clicking the Ok All butten.

Chense Cantrol = Get Special Control + Fan and a fan acen
will appear in the centre of the windows,

Selest the Fan and position it to the front and left of the wind
chime. Rotate the Tan woward the wind chime. Scale up the
seon about five times the current size using the (UND mode,

Select the entite wind chime higrarchy by using the right
mouse buttan, Choose Conerol = Sclect and pick 1he fan w0
assign it as a special control,

hove the time ling poanter o Game 1.

Chioase Simulate - Save Start/End o initialize the sinnalinion,
Choose Ramulate =+ Sirmulate Gratomma e o coeate the
animationm.

J:Ilfl}' 1|1|;' iIIIiI1:|iI|iIIJ'..

To et & mone dynamic animation, scile the fin Larger to
imcrense 1bs foroe.

Anirnate the fan by rotating it on the y-axis and seiting,
kevirames. Make the animation of the fan a ovcle, When a
simulation is created, a normal functien curve for the rotation

is automatically created and can be edited at any time.

§ Fecreate the simulation and play the animation,

|"” T'i‘"- To create s cvcle motion of the Tm, give three kevizames
o '

of ratation on the y-axis, The frst and last kevlrame
should have the same valoes. Selec) the Gin's v-ratation
function curve in the fuaction curve editor and cheose
FervEdit =+ Extrap mode = Cvele, The funcrion curve
should new be cvclical for the entire length of the
AR,




Actor Module

Cannon Ball and Trampoline

Simulations and Collisions

s Draw half the profile of the cannen using o Beeier apline irefer

S

tor the image ). Use the Surface = Revolution commmand 1o give
it volume

Adad 1he wheels (Fefer to the imagpe!,

Use 2 peimitive grid and a primitive cube to bwld the
trampoling {again, refer o the itnage?,

'l'_'.-:,':p}', seabi, and move the grid to create @ oot
Fosition the cannen away from 1he rrampoline on Ehre x-axas,

Ciet @ primitive sphere (patch object). Scale the sphere until i
fits i thie mouth of che cannoen,

et a kevirame for the sphers using SaveKey + Object =
Translation in the Mation moduole with the sphere ao the
Bontarn of the cannon, Maove the time line 1o frame 10, and
translate the sphere about 20 unite from the momh of the
canzon along the trajectory, Set a second keyframe,

In the Actor module, assign @ defaul phvsical property to the
sphere by choosing Dynamics + Physical Properties.

Move the time line pointer to Mrame 7 and save a starting frame
for the simulation by chocsing Simulate = Save StargEnd.
Create the first simulation by using Simulate + Simulace
rantomatic), Play the animation.

Tix adiust the trajeciory of the cannon ball, simply scale the
gravity vector and run the simulation again. Repeat this
process untll the splere hits the crampeline.

Lise Collistons < Select 1o assign the trampoline as a Bhox
Obstacle and the floor as a Bplane Obstacle.

g Create the simulation :|‘|_.';.’|Er'|.

Chaoose Thynamics + Physical Properties aml make sure
the sphere is seen a5 a bounding sphere object.

Select the sphere and choose ForvSeleot = Dynamics -+
Transition Cueve in the Motion sodule, a5 vou can
sew, Phas corve varics hetween Oand 1, with O
representing keyviramed sommation and | che simulated
ATAINATIG, TEEPeCiively
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Actor Madule

Cheers!

Articulated Chains, Flexible Envelope

Drraw the profile of a straw using a Bezer spline, Beler 1o
Figare | for the positioning of the contzal poings.

Make a B-Spline Parch ohject vsing Surface = Revolution
in the Model module. Refer to Figure 1 e chieck the result.

Activate the Grid Lok in the Frant window's Layoul dialoguoe
B,

Drraw an articulated chain inside the strave using theee joings
by choosing Skeleton + Draw 20 Chain in the Actor module
Peter to Figure 2 for the positien and direction of the chain.

Select the straw object and make a global assignment by
choosing Skin = Global Envelope and clicking on the chain. In
thie Ervelopes Datal Azsignomem dialogue bos, click O,

Choose Skin = Envelope Assipnment + Show Vertices and tag
all rowes of points en the straw abyect helow the roat ol the
articulated chain.

Chooses 5kin -+ Envelope Assignment = Feassign Manuallv
:|.r|-:_1 :;|i-:'k. CIrEEe i ome ol thee wenedowss wiatly 1he mnd ke mow e
buiton 1o remove the tag assignments frem the joints Uniag
'.]1|." I::"':'|:.ﬂ|\ I.I‘-il15 ||'|l\.' ::I'.il1l:;.|l!"' 1M LEe hl]:“l:'..

Cipen a Achemanic window and select the chatn elfector, Move
1t arcund by using Translate or the Supra Key v

o will nomice that the straw will deformm according to the
chain's ericntation.

Butld a glass and duplicate the siraw with tts chain to fnish
_'_-'|'|1'.r S,




Jumping Cube

Aotor Module

Articulated Chains, Explicit Translation

Select the Layout icon in the Front view window and activing
the Grid Lock.
Enlarge the Front view window and choose Skeleton = Draw

2T} Chain in the Actor madule 10 create a chain using oaly two
joints:

Foot logmion: =0 ¥=0 H=0
First leint location: X=-]1 Y= &Z=10
Effectar location: =0 Y=4 L=

Click the right mouse button 1o end the chain drawing
apreration,

Cieactivate the Grid Lock,

Geta primitive cuhe, transform and duplicate it
correspanding to madel 6 in the llustration. Make each join
the parent af the :'.|_:-J:l:|'|i'&-r'i&:l." cube.,

Select the whale chain and save six posilions wiing SaveKey =
Object + Explicit Translation in the Motion moedule. Refer 1o
the illusteation for the positions of the maodel ac each
keyframe, Timing for the root should be the following
keyfoames: 1, 8 12,16, 25, 30,

Flay the animation

You are mow ready to animate the eflector in the same wiy vou
amierinted the vom of the chain, Timing For the effector should
be the same kevframes: 18, 12, 16, 25, 30,

Play the amimation.

TR =0 T diad mem e
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Lotar Wodue

QOctopus, Part 2

B ] Quick Stretch

n Choose Get = Scene and select the Octapus scene vou created
as a Muode] project.

& Go 1o the Actor module by pressing the B3 supra key
m Select anly the body of the ecopus.

s {hoose (Stretel = Setup, In the Quick Stretch dizlogue box,
click o Flx and Ser for velocioy in the Maodes: overview area.
Then <lick k.

® Select the whole actopus haerarchy.

a Olver 100 frames, sot kevizames for rotation and translation.
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